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File menu commands

The File menu offers the following commands:

New Creates a new application.
Open Opens an existing application.
Close Closes an opened application.
Save Saves an opened application using the same file name.
Save As Saves an opened application to a specified file name.
Print Prints an application.
Print 
Preview

Displays the application on the screen as it would appear printed.

Print Setup Selects a printer and printer connection.
Exit Exits    Fuzzy Logic SC.



View menu commands

The View menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.

Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple applications in the application window:

New Window Creates a new window that views the same application.
Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 
2, ...

Goes to specified window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



New command (File menu)

Use this command to create a new application in    Fuzzy Logic SC.

You can open an existing application with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



File New dialog box

Starts new    Fuzzy Logic SC    application.



Open command (File menu)

Use this command to open an existing application in a new window.    You can open multiple 
applications at once.    Use the Window menu to switch among the multiple open 
applications.    See Window 1, 2, ... command.

You can create new applications with the New command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

Drives
Select the drive in which Fuzzy Logic SC stores the file that you want to open. 

Directories
Select the directory in which Fuzzy Logic SC stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close command (File menu)

Use this command to close all windows containing the active application.    Fuzzy Logic SC 
suggests that you save changes to your application before you close it.    If you close an 
application without saving, you lose all changes made since the last time you saved it.    
Before closing an untitled application, Fuzzy Logic SC displays the Save As dialog box and 
suggests that you name and save the application.

You can also close an application by using the Close icon on the application's window, as 
shown below:



Save command (File menu)

Use this command to save the active application to its current name and directory.    When 
you save an application for the first time, Fuzzy Logic SC displays the Save As dialog box so 
you can name your application.    If you want to change the name and directory of an 
existing application before you save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active application.    Fuzzy Logic SC displays the 
Save As dialog box so you can name your application.    

To save an application with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save an application with a different name.    A filename can 
contain up to eight characters and an extension of up to three characters.    Fuzzy Logic 
SC adds the extension you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the application.

Directories
Select the directory in which you want to store the application.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
applications you closed.    Choose the number that corresponds with the application you 
want to open.



Exit command (File menu)

Use this command to end your Fuzzy Logic SC session.    You can also use the Close 
command on the application Control menu.    Fuzzy Logic SC prompts you to save 
applications with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands such as File Open.    A check mark appears next to the menu item 
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in    Fuzzy Logic SC ,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Open a new application.

Open an existing application.    Fuzzy Logic SC    displays the Open dialog box, in 
which you can locate and open the desired file.

Save the active application or template with its current name.    If you have not 
named the application, Fuzzy Logic SC displays the Save As dialog box.

Print the active application.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the    Fuzzy Logic SC    window.    To display or 
hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



New command (Window menu)

Use this command to open a new window with the same contents as the active window.    You
can open multiple application windows to display different parts or views of an application at
the same time.    If you change the contents in one window, all other windows containing the 
same application reflect those changes.    When you open a new window, it becomes the 
active window and is displayed on top of all other open windows.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped 
fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Icons Command

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open application window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this application 
window.



1, 2, ... command (Window menu)

Fuzzy Logic SC displays a list of currently open application windows at the bottom of the 
Window menu.    A check mark appears in front of the application name of the active window.
Choose an application from this list to make its window active.



Application menu commands

The Application menu includes commands that let you develop and control your application:

Edit Linguistic    
Values

Enables user to add, delete and edit Linguistic values and 
Membership Functions

Edit Rules Enables user to add, delete and edit rules
View Linguistic 
Value

Enables user to select which Linguistic Value to display

Graph Settings Enables user to select the signals that will be displayed in 
graph

Method Enables user to select the MAX Criterion defuzzification method
Stimulus Enables user to    manually assign stimulus values to input 

signals 
Calculation Runs the calculation on stimulus assigned to signals 
File Export Enables exporting signal values to ASCII file
Show Rules List Shows all existed rules in separate window



Edit Linguistic Values (Application menu)

Edit Linguistic Values menu selection displays dialog box that enables user to manipulate 
with Linguistic Values and Membership Functions. 

To add new Linguistic Value:
1. Type the name of your Linguistic Value (i.e. p(bar)) in the combo box in Linguistic Values 
section
2. Click Add LV button
New Linguistic Value with the name p(bar) will be added to the list of Linguistic Values.

To delete existed Linguistic Value:
1. Select the existed Linguistic Value from the list of Linguistic Values in combo box in 
Linguistic Values section
2. Click Delete LV button
The selected Linguistic Value will be removed from the list and also deleted from memory.

To use Linguistic Value for adding, deleting and editing    Membership Functions:
1. Select the existed Linguistic Value from the list of Linguistic Values in combo box in 
Linguistic Values section
2. Click Accept LV button
The selected Linguistic Value is ready for adding, deleting and editing belonging Membership
Functions

To add Membership Function:
1. Type the name of your new Membership Function (i.e. large) in the combo box in 
Membership Functions section
2. Fill edit fields x1, x2, x3 and x4 with the values of your new Membership Function, like:

x1: 5.85
x2: 7.55
x3: 9.25
x4: 10.00

what means that this Membership Function will have the following shape:
T1(5.85,0); T2(7.55,1); T3(9.25,1); T4(10.00,0)
where T1, T2, T3 and T4 are corners of trapeze
3. Click Add MF button
New Membership Function with the name large will be added to the list of Membership 
Functions.

To delete Membership Function:
1. Select the name of Membership Functions from the list in combo box in Membership 
Functions section
2. Click Accept MF button
3. Click Delete MF button
Membership Function with the name will be removed from the list of Membership Functions 
and also deleted from memory.

To edit Membership Function:
1. Select the name of Membership Functions from the list in combo box in Membership 
Functions section
2. Click Accept MF button
3. Edit values for x1,..,x4
4. Click Edit MF button

Note 



You can not edit Membership Function name. In this case, you must first delete existed 
Membership Function and then add new one with the new name.

When you finish with this dialog box, press OK button. Remember that you cannot undo 
changes you made, because this dialog box does not have a Cancel button. All values are 
changed in the lists directly when you press buttons for adding, deleting and editing values.



Edit Rules (Application menu)

Edit Rules menu selection displays dialog box that enables user to manipulate with rules.

To add new rule:
1. Enter new rule in the form

IF lv1=mf11 AND lv2=mf21 AND ... THEN lvn=mfn1
in the edit field below the text Enter new rule or edit selected':
2. Click Save Rule button
New rule will be added to the list of all existed rules (if any). Remember that all rules must 
have the same format. When first rule has the form IF lv1=mf11 AND lv2=mf21 THEN 
lv3=mf31 then all other rules must have the same form: IF lv1=mf1x AND lv2=mf2y THEN 
lv3=mf3z, where mfn are Membership Functions corresponding to the existed Linguistic 
Values respectively. 

Note
When calculating output, program automatically takes the last Linguistic Value in rules (in 
section ...THEN lvn=mfnr) as output signal!

To edit existed rule:
1. Select the rule from the list of existed rules and click Edit Rule button
2. Edit Linguistic Values or Membership Functions section of the rule
2. Click Save Rule button
Changed rule will be moved to the end of the list of existed rules. 

To delete existed rule:
1. Select the rule from the list of existed rules
2. Click Delete Rule button
Selected rule will be removed from the list of rules and also deleted from the memory.

To copy rule:
1. Select the rule from the list of existed rules
2. Click Copy Rule button
Selected rule will be copied to the edit field on the top of the dialog box, where you can edit 
it.



View Linguistic Value (Application menu)

View Linguistic Value menu selection enables user to select which one from the existed 
Linguistic Values wants to be displayed on the screen.

To select existed Linguistic Value:
1. From the list of existed Linguistic Values select the one you want to display on the screen
2. Click OK button



Graph Settings (Application menu)

Graph settings menu selection enables user to select which signals (Linguistic Values) will be
displayed in graph. Graph graphically presents input signals and results of calculations. 

To select which signal (Linguistic Value) to display:
1. From the list of existed signals (Linguistic Values) select the signal you want to be 
displayed in graph.
2. Click Select button
3. If you want, you can repeat steps 1. to 2. to select maximum of three signals to be 
displayed in graph. 
4. If you want to change your selection, then click Delete button. This will remove all signals 
from the list of selected signals. After that, you can select new group of signals to be 
displayed in graph. 



Method (Application menu)

Method menu selection enables user to select one of three allowable Max Criterion 
defuzzification methods:
a.) MAX METHOD - left 
The most left maximum value on abscise is selected as output
b.) MAX METHOD - right
The most right maximum value on abscise is selected as output
c.) MAX METHOD - average
Performs Center of Gravity calculation on all maximum values on abscise

To select the method:
1. Click radio button before the name of method you prefer
2. Click OK button



Stimulus (Application menu)

This menu selection enables user to manually enter temporary signal values for calculation.

To enter signal values (stimulus):
1. From the list of existed signals (Linguistic Values) select the one you want to assign a 
value.
2. Enter signal value in the edit field 
3. Click <- Set    button

To view temporary signal (stimulus) values:
1. From the list of existed signals (Linguistic Values) select the one you want to check a 
value. 
2. Click Get -> button
3. Value for selected signal will be displayed in edit field
 
Note
 Stimulus is not saved when you choose File - Save or File - Save As menu command!



Calculation (Application menu)

This menu selection has no options, it just performs calculation according to the Linguistic 
Values, rules, stimulus and method entered by user. The result of calculation will be 
displayed in graph, if the output signal (Linguistic Value) was selected in Graph Settings 
Application menu command and in the graph in the middle of the screen. 



File Export (Application menu)

This menu selection displays standard File-OpenSave dialog box that enables user to enter 
filename for exporting temporary signal values in external ASCII file. One record is made 
after each calculation performed. Record has the following form:

date time,value of signal1,value of signal2,...value of signaln, like

13.07.95 20:15:58,1.25,8.66,12.50 ... ,5.55,

Note that you can not select which signal values (values of Linguistic Values) will be 
exported in this file. Program automatically exports temporary signal values of all Linguistic 
Values from active application in the same order as they have been entered (look    Edit 
Linguistic Values menu command).



Show Rules List (Application menu)

This menu command displays a separate window containing a list of all rules the application 
developer has entered by using Edit Rules menu command. By activating this window the 
list of rules can be printed on a system printer. 



 Fuzzy Logic SC    (Fuzzy Logic Software Controller)

 Fuzzy Logic SC    is a simple software tool with the aim to represent the possibility of fuzzy 
logic control. It is multi-input and single-output application.    Although its simplicity it could 
be useful for testing and developing    fuzzy logic control applications before the developer 
finally develops it in its own software or hardware application specific product    (see Sample 
Application) or for combining it with users data acquisition or control engineering application
(see OLE 2.0 Support).
 
This program calculates output according to the rules by using Min - Max    operator for 
fuzzification according to formula    

uMinMax = g*min(x , y)+(1-g)*max(x , y), where g=1 
and Max Criterion Method for defuzzification. User can decide how to interpret output from 
the set of all calculated maximum values by selecting the most left value, most right value 
or the value calculated from all maximum values according to the Center Of Gravity    
method. Program uses dynamically expanding lists and arrays for storing Linguistic Values, 
Membership Functions and rules and therefore the only limit for the number of elements is 
available system memory.      

If you have encountered any problems when using this program or if you have any 
comments, then please contact the author on address: 

Dejan Jovanovic
Vrbanska c. 18
62000 Maribor
Slovenija



OLE 2.0 Support

Fuzzy Logic SC is an OLE Automation Server and therefore supports communication between
application - specific MS Windows application (Application) that supports OLE 2.0 and the 
application the user has developed by using Fuzzy Logic SC. The Application can use the 
Fuzzy Logic SC capabilities of calculating output based on Linguistic Values, Membership 
Functions, rules, method and stimulus by using three methods that Fuzzy Logic SC exposes 
to other MS Windows based applications. Here is a short description of these methods:

BOOL SetValue(LPCSTR lvName, float inSignal)
- this method sets the temporary signal value of lvName Linguistic Value (signal) to the 
value specified by inSignal. It returns TRUE in all cases. 

float GetValue(LPCSTR lvName)
- this method gets the temporary signal value of lvName Linguistic Value (signal). It returns 
the float value of the signal. 

BOOL DoCalculation()    
- this method performs the calculation according to the Calculation application menu 
selection. 

Here are the main steps in implementing a communication between Application and the 
application developed by using Fuzzy Logic SC.

STEP 1:
- build a Fuzzy Logic SC application (see Sample Application). Save your work (remember the
name of    your application with full path, that is c:\fuzzy\sample.fld) and let Fuzzy Logic SC 
runs with your Fuzzy Logic SC application file (*.fld) opened. 

STEP 2: 
- build an MS Windows based application (in example below this is a Visual Basic 
application):

a.) in the main form place edit controls with the name p, dp and Result

b.) in the main form place button named Command1 and add the following Visual Basic code
(code is displayed in blue color) to its method Click:    

Sub Command1_Click ()
        Dim FLSC As object

FLSC is now an object
        Set FLSC = GetObject("c:\fuzzy\sample.fld")

object FLSC is now connected to the Fuzzy Logic SC application file sample.fld. We 
can use methods that are exposed by Fuzzy Logic SC object (in this example FLSC)
        a = FLSC.SetValue("p(bar)", Val(p.Text))
        a = FLSC.SetValue("dp(bar/s)", Val(dp.Text))

 By using SetValue(..) exposed method, p(bar) and dp(bar/s) Linguistic Values in 
sample.fld application now have temporary signal    values (stimulus) according to the ones 
contained in p and dp edit fields of Visual Basic application 
        a = FLSC.DoCalculation()

Fuzzy Logic SC performs a calculation on values (stimulus) entered before by using 
DoCalculation() exposed method
        y = FLSC.GetValue("output(V)")

By using GetValue(..) exposed method we can get the temporary signal value of 



output(V) Linguistic    Value (in this case the output signal)
        Result.Text = Str$(y)
End Sub

c.) build your Application 

- STEP 3: 
- run your Application. Fill the edit fields with the values for p(bar) and dp(bar/s) and click on 
Command1 button. You will see that Fuzzy Logic SC performs the calculation as it would be 
activated directly by using Fuzzy Logic SC menu commands, but the main window of it 
remains hidden. 

The OLE Automation Server capability of Fuzzy Logic SC is useful when the user develops its 
own SCADA application that supports OLE 2.0 and wants to add some fuzzy logic capabilities
to it but has no time to    write and test the code that is specific to fuzzy logic calculations.    
    



Sample Application

Control of pressure in Waterworks

Problem:
With the help of    Fuzzy Logic SC    we want to control the pump in some waterworks station 
(see Figure 1. below). We know that the optimum pressure at the outlet of the station ( p0 ) 
is approximately 4 bar    and that is the value we want to keep all the time (if possible). We 
also know that in some periods of the day the pressure ( pt ) can oscillate around the 
optimum value because of different reasons (changes in demand, unexpected events such 
as broken pipe, etc.). The aim of the application is to set the voltage on the output of the 
controller so that the pump will keep the pressure in the optimum limits. 

Solution:
We can build three Linguistic Values (see Edit Linguistic Values):
1. p(bar) - pressure as difference between pressure measured at the outlet of the station and
the optimal pressure (set value):

p(bar) = pt - p0; p0 = 4 bar
2. dp(bar/s) - change of the pressure from the last measurement made - shows the trend of 
pressure changing
3. output(V)    - output from the controller in the range of 0 - 10 V; 0 V means that pump 
must stop operating, and 10 V means that pump must operate with the maximum frequency
(U/f characteristic is controlled by external frequency converter)

Figure 1. - controlling the pressure in waterworks

After we have built Linguistic Values, we must add Membership Functions to each Linguistic 
Value:
 p(bar) has five Membership Functions:
- nl: T1(-4,0); T2(-4,1); T3(-3,1); T4(-2,0)
- ns: T1(-3,0); T2(-2,1); T3(-1,1); T4(0,0)
-z: T1(-1,0); T2(0,1); T3(0,1); T4(1,0)
- ps: T1(0,0); T2(1,1); T3(2,1); T4(3,0)
- pl: T1(2,0); T2(3,1); T3(6,1); T4(6,0)

 
dp(bar/s) has three Membership Functions:
- negative: T1(-2,0); T2(-2,1); T3(-0.5,1); T4(0,0)
- zero: T1(-0.5,0); T2(0,1); T3(0,1); T4(0.5,0)
- positive: T1(0,0); T2(0.5,1); T3(2,1); T4(2,0)

output(V) has four Membership Functions:



-    zero: T1(0,0); T2(0,1); T3(0,1); T4(0,0)
- small: T1(0,0); T2(1,1); T3(3,1); T4(4,0)
- middle: T1(3,0); T2(4,1); T3(6,1); T4(7,0)
- large: T1(6,0); T2(7,1); T3(10,1); T4(10,0)

Now we must get some information about the behavior of    the system in different 
situations. For this phase of application development we can observe the operating of the 
system or get information from    operator who used to manually drive this station. Finally we
present this knowledge in the form of rules (see Edit Rules) as follows in example:

IF p(bar)=z AND dp(bar/s)=negative THEN output(V)=small

what means: if pressure is in the limits of optimal and trends to fall, then we should start to 
run pump. Then we will wait to see what happens next.

Here is the collection of all rules:

IF p(bar)=nl AND dp(bar/s)=negative THEN output(V)=large
IF p(bar)=nl AND dp(bar/s)=zero THEN output(V)=large
IF p(bar)=nl AND dp(bar/s)=positive THEN output(V)=middle
IF p(bar)=ns AND dp(bar/s)=negative THEN output(V)=large
IF p(bar)=ns AND dp(bar/s)=zero THEN output(V)=large
IF p(bar)=ns AND dp(bar/s)=positive THEN output(V)=small
IF p(bar)=z AND dp(bar/s)=negative THEN output(V)=small
IF p(bar)=z AND dp(bar/s)=zero THEN output(V)=zero
IF p(bar)=z AND dp(bar/s)=positive THEN output(V)=zero
IF p(bar)=ps AND dp(bar/s)=negative THEN output(V)=zero
IF p(bar)=ps AND dp(bar/s)=zero THEN output(V)=zero
IF p(bar)=ps AND dp(bar/s)=positive THEN output(V)=zero
IF p(bar)=pl AND dp(bar/s)=negative THEN output(V)=zero
IF p(bar)=pl AND dp(bar/s)=zero THEN output(V)=zero
IF p(bar)=pl AND dp(bar/s)=positive THEN output(V)=zero

Now we select the Linguistic Value to display on the screen (usually output signal, so we 
select output(V) - see View Linguistic Value) and signals that will be displayed in graph 
(maximum number of signals to be displayed is three, so we can select p(bar), dp(bar/s) and
output(V) - see Graph Settings). After we have completed defining visualization, we can 
choose File Exportutility that enables archiving of signal values in ASCII files. After that we 
can select Method to select calculation method, enter stimulus values for our system (see 
Stimulus) as shown in examples and select Calculation menu selection to perform 
calculation: 

Example 1:
pt= 3 bar => p(bar) = pt - p0 = 3 - 4 = -1
dp(bar/s) = -0.25
=> output(V) = 8.25
what means: because pressure is less than optimal and it trends to fall, the controller    has 
to start running the pump.

Example 2:
pt= 4 bar => p(bar) = pt - p0 = 4 - 4 = 0
dp(bar) =    0.7
=> output(V) = 0.0 
what means: because pressure is in the range of optimal and it    is to be on the rise,    the 
controller has to stop the pump.



Note: this sample application is only for the purpose to show the user how to work by using 
Fuzzy Logic SC    program. User has to edit Linguistic Values, Membership Functions and 
rules to build some more applicable and real - world application.      

    



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using Fuzzy Logic SC and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of    
Fuzzy Logic SC software.



Context Help command 

Use the Context Help command to obtain help on some portion of    Fuzzy Logic SC.    When 
you choose the Toolbar's Context Help button, the mouse pointer will change to an arrow 
and question mark.    Then click somewhere in the Fuzzy Logic SC window, such as another 
Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

Fuzzy Logic SC

The title bar is located along the top of a window.    It contains the name of the application 
and application.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Application Control-menu button
Maximize button
Minimize button
Name of the application
Name of the application
Restore button



Scroll bars

Displayed at the right and bottom edges of the application window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the application.    You can use 
the mouse to scroll to other parts of the application.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Fuzzy Logic SC window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges an application window.



Next Window command (application Control menu)

Use this command to switch to the next open application window.    Fuzzy Logic SC 
determines which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (application Control menu)

Use this command to switch to the previous open application window.    Fuzzy Logic SC 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single application, the Close command on 
the application Control menu closes only one window at a time.    You can close all windows 
at once with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes an application window

ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Ruler command (View menu)



Choose Font dialog box



Choose Color dialog box







Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>

    



Update command (File menu)

<< Write a topic here that discusses the Update command. >>



Save Copy As... command (File menu)

<< Write a topic here that discusses the Save Copy As... command. >>



Embedded Object Resize Bar

<< Write a topic here that discusses the embedded object resize bar. >>



                                                
          




